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AKVIS INSPIRE AI 2.0 | ARTISTIC STYLIZATION OF IMAGES

AKVIS Inspire AI stylizes images using various samples of painting. The program copies the color scheme and style of an art sample
to a photo creating a new masterpiece. Turn your photos into famous paintings with the help of artificial intelligence!

Now you can become an artist using neural networks!

AKVIS Inspire AI allows you to create incredible works of art from your photos using a reference image. By imitating the brush
strokes, color palette, texture, and artist technique, artificial intelligence creates remarkable digital paintings indistinguishable from
masterpieces of traditional art.

The program opens up limitless possibilities for creativity.

AKVIS Inspire AI includes a gallery of art styles to apply and allows you to load a custom image as a sample. The program adapts
your photo according to the chosen style, creating a unique work of art.

Imitate the style of world famous artists! Paint like Picasso or Van Gogh!
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AKVIS Inspire AI not only makes digital creativity accessible to everyone, the program is an invaluable tool for artists, allowing them
to try different styles, create original compositions, expanding the boundaries of creativity and artistic expression.

The trial period has no restrictions. You can create a lot of artworks free of charge within 10 days!

Users have full control over settings and can experiment and try a variety of styles. It's possible to load any image as a style sample
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and transform a photo into something special.

The program supports the Batch Processing feature that helps to render multiple photos in one style or to apply different styles to
one image.

Unleash your creativity and make awesome paintings!

AKVIS Inspire AI is available as a standalone program and as a plugin filter for graphics editors: AliveColors, Adobe Photoshop, Corel
PaintShop Pro, etc. Check the list of the compatible image editors.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or re-run
the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-mail
address and confirm that you accept the Privacy Policy.

8. Press Finish.
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After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the desktop, if
during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop:
Filter -> AKVIS –> Inspire AI, in AliveColors: Effects -> AKVIS –> Inspire AI.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-inspire-app.dmg to install the Standalone version

- akvis-inspire-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Inspire AI application or AKVIS Inspire AI PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Inspire AI app into the folder Applications (or any other place you like).

To install the Plugin, drag the entire AKVIS Inspire AI PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Inspire AI, in AliveColors: Effects -> AKVIS -> Inspire AI.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and later
versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using the
uname -srm command.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS Inspire AI 
sudo apt-get install akvis-inspire

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-inspire --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS Inspire AI:

when using the dnf package manager: 
sudo dnf install akvis-inspire

when using the yum package manager: 
sudo yum install akvis-inspire

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-inspire

when using the yum package manager: 
sudo yum remove akvis-inspire

 

Installation on openSUSE.
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1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS Inspire AI: 

zypper install akvis-inspire
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-inspire

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Inspire AI and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the number
of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10
days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home
(Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the program.
Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for
example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Inspire.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in Users’
Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder, select the Go menu, then select Go to Folder... (⌘ +Shift+G ), type "/Users/Shared/AKVIS",

and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!

AKVIS Inspire

14

mailto:activate@akvis.com


 

When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change Home to
Home Deluxe or Business).
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WORKSPACE

AKVIS Inspire AI can work independently as a standalone program and as a plugin with compatible image editors.

Standalone is an independent program. You can run it in the usual way.
Plugin is an additional modul installed into graphics editors. To call the plugin, select it from filters of your image editor.

The AKVIS Inspire AI program window looks like this:

AKVIS Inspire AI Workspace

 

Elements of the program window:

Most of the program's window is taken up by the Image Window. At the bottom there is a collapsed panel with the Original, Style,
and Result tabs. The panel can be expanded to view all images at the same time.

 

In the upper part of the program's window, you can see the Control Panel with the following buttons:

The button  opens the home page of AKVIS Inspire AI.

The button  (only in the standalone version) opens an image for processing. The hotkeys are Ctrl+O  on Windows, ⌘ +O

on Mac.
The button  (only in the standalone version) saves image to the disk. The hotkeys are Ctrl+S  on Windows, ⌘ +S  on

Mac.
The button  (only in the standalone version) opens the Print options. The hotkeys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series of

images.
The button  opens the Gallery of Styles in the Image Window.

The button  cancels the last operation made with the tools. It is possible to cancel several operations in a row. The

hotkeys are Ctrl+Z , on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation made with the tools. It is possible to return several operations in a row.

The hotkeys are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  starts image processing with the current parameter settings.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  calls information about the program, version, and license.

The button  calls the Help files. The hotkey is F1 .

The button  calls the Preferences dialog box.

The button  opens a panel with the latest news about the program.

 

To the left of the Image Window, there is a Toolbar. Different tools appear depending on the conditions.
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Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is visible in
the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible portion of
the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Navigator

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then holding down
the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and holding Ctrl  (⌘  in

Mac) – while using the scroll wheel will move the image left and right. Holding Alt  (Option  in Mac) will scale the image. Right-click

on the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases. When you
move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter  (Return  in

Mac). Frequently used scale coefficients can be found in a drop-down menu.

You can use hotkeys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and Ctrl+-

(⌘ +-  in Mac) to reduce the scale.

 

Below the Navigator, there is the Settings Panel with effect parameters.

Under the settings, you can see Hints for the parameters and buttons when you hover over them with the cursor. You can choose
where the hints will be shown or hide them in the Preferences.
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USING THE PROGRAM

AKVIS Inspire AI performs stylization of images using various painting samples. The software can be used as a standalone program
as well as a plugin filter with graphics editors.

Follow these instructions to make a new artwork using a style sample:

Step 1. Open an image.

- If you work with the standalone version:

Double-click in the empty workspace or use . You can also drag the image into the program workspace or double-

click within the Original tab in the bottom panel. The software supports RAW, JPEG, PNG, BMP, WEBP, and TIFF file
formats.

- If you work with the plugin:

Open an image in your graphics editor and call the plugin in the Filter/Effects menu:

in AliveColors: Effects -> AKVIS -> Inspire AI;
in Adobe Photoshop: Filter –> AKVIS –> Inspire AI;
in Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Inspire AI;
in Corel Photo-Paint: Effects –> AKVIS –> Inspire AI.

AKVIS Inspire AI Workspace

Step 2. Optionally, you can use the Crop tool  to crop the original image or modify a sample.
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Crop Image

Step 3. Select a stylization sample from the Gallery of Styles. You can open the gallery using  or double-clicking within

the Style tab in the bottom panel.

The samples in the gallery are divided into groups: Landscape and Portrait.

You can load any image as a sample using the Custom Style button and edit it with the Crop  and Stamp  tools.

Gallery of Styles

Step 4. Adjust the effect parameters.

Please note that the result of the neural network is quite unpredictable. These parameters are mainly technical. Do not use
high values for the working size parameters (Image Size and Sample Size) on slower computers.

Run  to start processing. Click the Cancel button to the right of the progress bar to interrupt the calculation.
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Effect Parameters

Step 5. You can save your settings as Presets. To save a preset, enter its name into the Presets field and press Save.

You can return to the default settings of the selected preset by pressing Reset.

To remove your preset, select it from the list and press Delete.

Step 6. In the standalone version, you can also print your image.
Step 7. Save the result.

- If you work with the standalone version:

Click , enter a name for the file, choose the format (TIFF, BMP, JPEG, WEBP, or PNG), and select a folder.

- If you work with the plugin:

Click  to apply the result. The plugin will close and the image will appear in the workspace of the graphics editor.

Save the image in the graphics editor.
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Styled Image
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Magnify & Smooth on Magnify & Smooth off

ARTISTIC STYLIZATION OF IMAGES

AKVIS Inspire AI stylizes images using various samples of painting, copying the color scheme and style of a sample.

Stylized Artwork

Effect Parameters:

Magnify & Smooth. The check-box activates the upscaling method that provides additional smoothing and enhancement of
the image quality. If you want to emphasize texture and keep some grain for creating high-detail paintings, you can disable this
option.

Proportional Preprocessing. Preliminary processing of the original and style images. If the check-box is enabled, the neural
network uses both images keeping their aspect ratio. If the check-box is disabled, the images are compressed into a square
during the processing.
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Proportional Preprocessing on Proportional Preprocessing off

Image Size= 288 Image Size = 2048

Sample Size = 384 Sample Size = 2048

Image Size. The working size of the original image that affects detail. The smaller image gives a rougher result. Higher values
improve detail if the actual size of the image is large.

Sample Size. The working size of the style sample used by the neural network.

Hint: First of all, the ratio of working sizes matters. The larger the Sample Size than the Image Size, the more the style will
be pronounced. Usually the best result is achieved when the working image size is twice the size of the sample.

Attention! As soon as one of the working sizes (Image Size o r  Sample Size) exceeds the Use CPU value in the
Preferences, calculation will switch from GPU to CPU and will slow down.

Image Blur. Preliminary smoothing of the original image. Reduces detail and noise.
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Image Blur = 0 Image Blur = 60

Sample Blur = 0 Sample Blur = 60

Single Processing Double Processing

Sample Blur. Preliminary smoothing of a style image.

Iterations. Number of processing iterations. For weakly expressed styles, we recommend to use 2-3 iterations to enforce the
effect.
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GALLERY OF STYLES

To open the Gallery of Styles click  or double-click within the Style tab in the bottom panel.

The samples presented here are divided into the groups (in the drop-down list): Landscape, Portrait, Architecture, and Flowers.
You can apply a sample from any group or load your image and use it as a reference.

Adjust the size of thumbnails in the gallery using the slider.

A preview of the selected style will appear in the Style tab in the bottom part of the program window.

It would be great if the Original photo is similar in composition to the Style to get the best result. This is a recommendation, but
not a requirement. You can use a sample from any group or any other artwork. Some designs are perfect for any occasion and any
image, no matter the group name.

You can load your sample using the Custom Style button and edit it with Crop  and Stamp .
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Start processing with  - and the original image will be styled using the selected sample.
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Before Using Crop
(Too Much Blue Appeared)

 

Cropping Custom Sample 
(Reducing Blue)

 

After Using Crop
(Re-generated Result)

TOOLS IN INSPIRE AI

AKVIS Inspire AI is designed for copying color gamma and artistic techniques and creating stylized images.

Depending on the conditions, different tools will be available in the Toolbar. For example, you can edit your style sample with the
Crop and Stamp tools.

Crop . The tool allows you to cut off odd parts of the image leaving the desired fragment.

Select an area to keep, click OK or press Enter . If you need to cancel the operation, use the Cancel button or Esc -key. To

return the crop area to its original state, click the Reset button.

You can use the tool  in two modes: to crop the image and to modify a custom style.

1. Crop the image (only in the standalone program):

Use the tool to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and
contrariwise.

Using Crop Tool

2. Modify a custom style (in both standalone and plugin, for custom styles only):

Cropping the custom sample changes the result. Using the tool in this mode, you can remove some colors and emphasize
different style elements.
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Before Using Stamp
(Unwanted Details Generated)

 

Hiding Details with Stamp
(Removing Details from the Custom Sample)

 

After Using Stamp
(Re-generated Result)

Crop options:

You can choose the size of the crop rectangle using the Ratio or Fixed Size options.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.

 

Stamp  (for custom styles only). It works as a clone stamp tool. Draw over the sample elements to hide unwanted

patterns and details, for example, eyes which can be unintentionally copied by the neural network from a sample to the image.

To hide undesired parts in the sample, select a source to copy by holding down Alt  (on Mac - Options ) and paint over the

areas which you want to remove.

Change the size of the tool in the pop-up window shown by right-click in the image.

Hand . The tool lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click

on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction.
The hotkey is H .

Double-clicking the tool's icon  on the Toolbar makes the image fit the window.

Zoom . The tool allows you to change the image scale. To zoom in left click on the image. To zoom out left click with Alt

on the image. The hotkey is Z .

Double-clicking the tool's icon  makes the image scale to 100% (actual size).
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PREFERENCES

Click  to open the Preferences dialog:

Language. Choose the program language in the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will automatically
scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. The parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;

- 100%. The actual size is used, the image doesn't scale.

Recent Files (only in the standalone version). The number of recent documents. The list of the recent files, sorted by time,
become visible by right mouse clicking on . Maximum: 30 files.

Hints Panel. When you hover over parameters and buttons with the cursor you can see a brief description of them in the
Hints field. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Lock the Control Panel. The check-box disables the possibility to hide/show the top panel. If the option is selected, the panel
is always visible.
Use CPU. A threshold size of images above which switching from CUDA to processor occurs. To speed up calculations, you can
increase the threshold. If the program starts to crash, reduce this parameter. For weak video cards (4 GB or less), it is not
recommended to increase this value.

Click OK to apply the changes. To reset to the default options, click Default.
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BATCH PROCESSING

In AKVIS Inspire AI, it is possible to edit a series of images using the batch processing feature.

Batch processing is useful for rendering multiple photos in one style or to apply different styles to one image.

If you use the plugin, create an action in your graphics editor, then apply it to the folder in the batch mode. All images will be
processed in the selected style. Learn more.

To use the Batch Processing feature in the standalone program, follow the steps:

Step 1. Run the AKVIS Inspire AI program. Adjust the algorithm parameters in the Settings Panel. These settings will be
applied to all images and styles. Save them as a preset.

AKVIS Inspire AI

Step 2. In the top panel, click  to open the Batch Processing dialog box.
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Batch Processing in AKVIS Inspire AI

In the Source Folder field, select a folder containing the images for processing.
Alternatively, you can specify one image in the Source File field.

In the Target Folder, choose the folder where the processed photos will be saved. Check Include All Subfolders to process
all images in all subfolders of the selected folder (keeping the structure).

Select your Preset.

In the Save As list, choose the format and quality of the images.

In the File Name field, specify the names of the output files:

Source Name - the processed files will be saved with their original names. 
Add Suffix - the specified character set will be added to the original names. 
New Name - the names of all files will be replaced with the specified name with the addition of a sequence number.

The Styles section contains a list of styles integrated into the program that can be used for processing. Click the style name
to see a thumbnail example on the left.

Select one or more styles.

The All Styles check-box allows you to select/unselect all styles.

The Custom Styles button allows you to upload your own styles and include them in batch processing. The downloaded
samples will appear in the list under the name Custom-001, Custom-002, etc.

Step 3. Click the Start button to run processing all images.

Image Processing
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PRINT IMAGES IN AKVIS INSPIRE AI

In the standalone version of AKVIS Inspire AI you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Inspire AI

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the print
margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These parameters have
no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in
%, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.

Print Page
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Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the image on
the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large
picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will
automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be
added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be printed in
the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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HOW TO ENHANCE A DIGITAL ILLUSTRATION USING INSPIRE AI

Unlike with traditional art, creating digital art is accessible to almost anyone. It is one of the most enjoyable creative processes that
merges artistic vision with the power of technology. There are many ways to improve your digital art, depending on your skill level
and the specific techniques you're using.

In this tutorial, you'll discover how AKVIS Inspire AI can significantly elevate the quality of your digital art and illustrations. Using
the software, you can get multiple variants of the same image in a click and make your digital art more "painterly", dynamic, and
visually interesting.

Artistic Stylization: Before and After
(click to open a larger version)

Step 1. Open AKVIS Inspire AI. Open the source image using the  button on the top bar or double click the Original tab

at the bottom of the program window.
Step 2. In the Gallery of Styles, select a style sample. We use Architecture-23. Click  to run the processing.
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First Result

Step 3. The initially flat image is given more depth and complexity. You can make the artistic effect more pronounced by
decreasing image details and intensifying the style features. To do so, increase the value of the Sample Size parameter and
decrease the Image Size. It's how the image now looks like:

Adjusting Settings
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Compare the results: more details vs. less details. Both variations are fine and you can use the one you prefer or even make a
combination of two images uisng layers and layer masks.

More Details vs. Less Details

Step 4. Save the result by clicking on .

Step 5. Another option to diversify your digital content is usig different style samples. Experiment with different styles and
style categories! Sometimes the best results come from the most unexpected ideas. Here are the results we get:

Style: Flowers-022.
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Style: Landscape-04.

Style: Architecture-011.
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Style: Architecture-020.

Style: Architecture-024.
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Using AKVIS Inspire AI, you can make your images look dramatically different and far more visually appealing. Look at the
variety of results we got in just a few clicks!
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All Results
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STYLIZE VIDEOS USING BATCH PROCESSING

Batch processing makes it possible to convert multiple images with the same settings. If you are a fan of the AKVIS Inspire AI
program, then instead of one picture you can process a sequence of frames, combine them, and get an exclusive video effect.

Stylized Frame

Step 1. Split your video into frames. To do this, you will need a video editor (for example, Adobe After Effects). Follow the
instructions:

1. Open the video in the video editor (Import -> File) and create a composition (New Comp from Selection).
2. Select in the menu Composition -> Add to Render Queue.
3. Double-click the Output Module element to show the output module settings.
4. Set the saving format JPEG Sequence. Here you can reduce the frame size to 25% of the original in order to later work

with small videos (960*540). Click OK.
5. In Output To specify the name of the destination folder, where the frames will be saved (for example, "C0018-orig-

small"), and the file names.
6. Click Render.

Video to Images Conversion

Alternatively, you can use any video to image sequence converter. There are many tools and online services.

Step 2. Run AKVIS Inspire AI, open any file from the "C0018-orig-small" folder and adjust the settings.
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In the top panel, click  to open the Batch Processing options.

First of all, we will select a style in the batch mode.

Check the desired styles (you can select all) and start processing only for one image, choosing it as a Source File. Save the
results to the "C0018-styles" folder.

The styles do not always fit well with the image. This method allows you to compare different styles and choose the one you
like (for example, we choose Portrait-35).

Style Comparison
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Step 3. Open the batch options again . This time we will process all images using the style selected in Step 2.

Specify the folders paths. Choose the style that will be used as a reference.

Click the Start button. The program will process one frame after another from the "C0018-orig-small" folder and save each
result to the "C0018-result-inspire" folder.

Step 4. Now all that remains is to combine images into a video. How to do this in Adobe After Effects:
1. Import a folder with images into the video editor (you can simply drag it into the project window).
2. Create a composition.
3. Apply the Posterize Time filter (value 8-12 frames) from the Effects & Presets panel so that there is no flickering in

the video.
4. Select in the menu Composition -> Add to Render Queue and start rendering. By default, the video will be saved in

QuickTime (.mov) format.

Let's watch the final video and admire the result!
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SEASCAPE PAINTING

We all know how beautiful seascapes are! The azure blue of the waves crashing on the shoreline, the gold of the sand dunes, and
the radiant white of sailboats have inspired artists for centuries. The seascape paintings or “marines” as they are known in the art
world depict scenes of the sea and the surrounding coastline. They may be soft and dreamy or dramatic and impetuous, depending
on the message the artist wants to convey.

Using AKVIS Inspire AI you can create wonderful seascape paintings out of photos. Just choose the suitable style reference and
the program will create a work of art worthy to hang on the wall or gift to a friend.

Follow the steps to create your own artwork.

Artistic Stylization: Before and After
(click to open a larger version)

Step 1. Open AKVIS Inspire AI. Open the source image using the  button on the top bar or double click the Original tab

at the bottom of the program window.
Step 2. Open the Gallery of Styles. You can either use the  button on the top bar or double click the Style bottom tab.

Step 3. Click the Custom Style button. Select an image to use as the style sample.

Often the use of an image that is similar in subject matter has a positive effect on the final result. Since we want to stylize
the seascape, we choose a similar painting as a reference.
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Step 4. Process the image using default settings by clicking . The result is quite good, but we would like the style to be

more pronounced.

To make the style more pronounced, reduce the size of the image and increase the size of the style sample.
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Step 5. You can also make the painting even more realistic by adding some canvas texture using AKVIS ArtSuite.

Step 6. Save the result by clicking on .
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HOW TO APPLY CUSTOM STYLES IN INSPIRE AI

The AKVIS Inspire AI software allows you to perform image stylization using various style references. Moreover, you can use not
only the built-in samples, but also upload your own styles.

In this tutorial, we will guide you through how to load and apply your own style reference.

Artistic Stylization: Before and After
(click to open a larger version)

Step 1. Open AKVIS Inspire AI. Open the source image using the  button on the top bar or double click the Original tab

at the bottom of the program window.
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Step 2. Open the Gallery of Styles. You can either use the  button on the top bar or double click the Style bottom tab.

Step 3. Click the Custom Style button. In the open image dialog, select an image to use as the style reference.
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This is how our custom style looks like:

Step 4. Adjust the settings and start processing using . Save the result by clicking on .

 

Here are some more images processed using this style sample. See how the same style works on different images.
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Still Life

(click to open a larger version)

Still Life II

(click to open a larger version)
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American Indian

(click to open a larger version)

White Tiger

(click to open a larger version)
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Pomegranates

(click to open a larger version)

 

AKVIS Inspire

52

http://akvis.com/img/examples/inspire/examples/inspire/custom-style/pomegranate-big.jpg


AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that
sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen
settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the quality of
compressed images. This program provides 4 image enhancement modes, each involves a unique neural network developed especially
for this occasion. The software is available free of charge for home users. For commercial use, a Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture
samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor, Gouache,
Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very easy
to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make
professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects,
such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your digital
images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume
of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently.
Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo
with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress,
and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you
improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies dust and
sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can
also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style of a
selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load a custom
sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for
adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your
pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural network-
based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints. Improve image
resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your skin
radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every
photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program includes a
number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn
with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing any
type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software includes AI
technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The
unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a
painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the
most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the
software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating a
selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five image
processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains,
and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information
of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W sketches,
imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles: Classic, Artistic,
Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…
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AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software
considerably increases your productivity. You will be freed from boring work and will have more room for creativity and realization of
your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles of
photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use presets.
The software turns ordinary images into aquarelle pieces of art. More…
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